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Inspiring excellence in digital print

Alison’s 10 yeAr service helps 
intec mAke A difference…

march 2016 marked the 
tenth anniversary at intec 
for Alison Ashford, our 
international consumables 
sales manager, based in 
the intec Uk office.

As the hub and fount of all 
knowledge on consumables - and 
for many of our partners - the person 
they might know the best at intec, 
Alison has proven to be invaluable in 
helping intec make a difference, on 
all fronts over the years.

Alison’s career started at Intec in March 
2006, with a position in hardware sales, 
selling the Intec CP2000 and Canon 
LFPs into the UK market. Since then, 
she has moved into consumables sales 
and has sold several million toners  – 
not to mention drums, plates, spare 
parts, blades, media …and so on!

In looking back over the past decade, 
Alison has calculated that she has sold 
to clients in over 140 countries - as 
far apart as Korea, Uruguay, Benin, 
Swaziland, Russia and beyond. But as 
anyone who knows Alison well, will tell 
you, she does like to be kept really busy!

Now in the role of consumables sales 
manager, she would like to thank her 
co-workers and team mates who have 
made her daily life at Intec interesting 
and enjoyable. 

“I am very thankful that Intec has 
provided me with opportunities for 
self-development, and  have really 
enjoyed the last 10 years – goodness 
knows where the time has gone, but 
here’s to many more.” Alison

Alison Ashford, celebrating 10 years with the company, with Ian Melville, Intec MD.

10 years’ Celebration chocolate cake 

Time to celebrate
To celebrate this milestone, the UK 
team gathered with Alison, in the 
boardroom - when the company laid on 
a hot breakfast - all rounded off with a 
very lush celebration chocolate cake. 
Ian Melville, Intec MD, toasted Alison 
by saying, “Thank you Alison, your long 
service and commitment is very much 
appreciated and has certainly gone a 
long way towards the company being 
able to make a difference.”

Making a difference
Through the consumables side of the 
business, Intec makes a charitable 
contribution from all toner sales 
to projects which have included, 
over the last 10 years: a school and 
church / community centre in Sri 
Lanka, water for maternity hospital 
in Malawi, maternity unit in Burkina 
Faso, sponsored children in Uganda, 
sponsored deaf children to be able to 
have an education in Ghana …to name 
but just a few.  To our customers, we’d 
like to thank you all so much, for your 
valued and sustained business.

The maternity unit in Burkina Faso which is 
currently being supported by Intec sponsorship
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AUstrAliA showroom reAdy for 
Action And doing good bUsiness

Full range of Intec products permanently available for demonstration at our new premises

maria gagetti, director of 
intec Australia, reports a 
brisk first month of trading.
“Since opening our doors for business 
in March, interest in our digital 
solutions has been over-whelming, 
it’s been fantastic having a full diary of 
appointments and the team has been 
brilliant in meeting the demand.”
call: +61 1300 292 944 to discuss 
your needs and to book your demo.       

emAil from A very hAppy U.s.  deAler

from our intec 
U.s. inbox…
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®

mAster clAss #4.1
continuing our ‘master class’ series, to help you get the very best from 
your intec equipment, this is part three of an in-depth mulit-part series 
on ‘Advanced color control’.

this new series focuses on 
a number of the key benefits 
included in the fiery® Xf for 
intec - upgrade v6.21 
We start with step & repeat business 
cards, with non-overlapping crop 
marks and bleed.

our in-depth ‘master class’ series is back, helping you get the very best 
from your intec digital printing equipment.

6.21
This particular feature of the Fiery XF will 
allow optimization of media coverage by 
fitting maximum ‘jobs’ per sheet – and also 
minimize finishing time by reducing the 
number of cuts required on the guillotine.

crop marks can now be set with a greater 
degree of control; not only enabling the 
actual length of crop mark and their 
distance to job, but also whether or not 
crops appear in the gutters and alleys.

bleed can also be controlled to feature 
specific amounts on all four sides of the 
jobs, this will enable the butting-up of bleed 
areas without intermediate crop marks, or 
removal of intermediate bleed totally, and 
the butting-up of trim areas, thus minimizing 
the number of cuts required.

watch the video tutorial

Follow the above link to view the 4 minute 
video demonstrating the process. 

1. Take full control of bleed, step and repeat 
and crop marks

the process, step-by-step
To illustrate the process, we will use our 
business card sample file which features 
bleed but not crop marks. We suggest you 
create a similar file to help follow this guide.

To help automate this particular process, 
the Fiery XF v6.21 now features a new 
pre-set workflow queue, named ‘Intec 
Proofing with bleed’, simply drop the job 
into this queue, pic 2. 

As shown in pic 3, the full job area plus 
its bleed, appears in the RIP preview 
window.

The is populated automatically because 
the queue options are set with ‘Trim Box 
including Bleed, as shown in pic 4. 

In the [Printers marks] tab, tick the ‘Crop 
marks’ check box – the crop marks are 
added around the media’s bounding box - 
but no bleed is included, as yet pic 5.

To ask the RIP to show the job’s bleed, go 
to the [Layout] tab pic 6, and adjust the 
desired amount within the ‘Job margin’ 
co-ordinates, up to the maximum amount 

…continued

https://youtu.be/rzVHpmwX7Vo

1

2. Drop the job into the ‘Intec Proofing with 
bleed’ workflow queue in the Fiery® RIP

2

3. Our demo artwork shows the ‘job area’ of the 
business card indicated by the red box line

3

4. ‘Trim Box including bleed’ in [File] tab and 
PS/EPS/PDF option and ‘Size definition’

4

5. Tick the ‘add crop marks’ check box in the 
‘Priners marks’ tab menu

5

https://intecprinters.iweb-storage.com/s/IjU2ZmU1NTJiNmExODkyNDgwMmZjMmQzMyI.JHHzBZxklv62c-Kt8Wyil5L8z6k
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mAster clAss #4.1…continUed
included within the artwork. Note, the 
crop marks might overlay the bleed area.

This can be controlled by adjusting the 
‘Distance to job’ settings in [Printer marks] 
tab - you’ll see the marks will move in or 
out as you make these adjustments, pic 7.

step and repeat the job with 
total control over bleed and 
crop marks
At this point, we can choose to step and 
repeat the job to fill the output media page 
size. Typically a standard 85mm x 54mm 
business card will fit 10-up on an A4 sheet.

In the [Layout] tab and Step and repeat 
menu (tick the check box so you are able 
to action changes), check the ‘Rows and 
columns’ button and then enter the desired 
number of rows and columns to suit the 
job. In our example, we have opted for 2 
rows x 3 columns, pic 8. 

Once ‘step and repeat’ has been applied, 
a series of gutters and alleys appear 
between the jobs. The amount of bleed 
is shared 50% in this space, ie: a 5mm 
bleed will show 2.5mm in each bleed 
area. Depending upon the artwork’s 

design, this configuration may be 
perfectly suitable pic 9. 

However, depending upon the possible 
absence of bleed content in the design, or 
accuracy of trimming machinery, it might 
be desirable to take advantage of the 
Fiery’s upgraded functionality to remove 
crop marks and bleed within the alleys 
and gutters - thus butting the job areas up 

to each other and seriously reducing the 
number of cuts required to finish the job! 
pic 10.

To go about completely removing gutters and 
alleys, set the ‘Spacing’ to zero ‘0’, pic 11.

This additional procedure would reduce 
the number of cuts required to finish a 
10-up business card job, from 14 to only 9. 
A worthwhile production time saving!

top tip
bleed design 
with head to toe 
orientation
Business cards with 
bleed do look good. So 
by limiting your design 
to bleed off on only the 
top or bottom edge, will 
offer the opportunity to flip 
alternate rows of the step and 
repeated artwork to have the 
bleed edges butting up to each 
other. This enables the use of just 
one cut between cards and will 
minimize any sign of inaccuracy 
in trimming.  This process was 
fully covered in our March 2015 
MasterClass if you want to refer 
back to it. 

desperate to know more?
Just give me a call  
and I’ll share our  
knowledge with you.

Mark Baker-Homes 
Director Business Development

6. The ‘Job margins’ coordinates controls the 
amount of bleed shown

6

7. The ‘Distance to job’ coordinates controls
 the positioning and set of the crop marks

7

8. Step-and-repeat the job to fill the output 
media sheet as required

8

9. Control the bleed in ‘gutters and alleys’

9

10. Butt-up job areas to remove bleed and 
crops in ‘gutters and alleys’

10

11. Setting the ‘Spacing’ to zero, will remove 
gutter and alley content and butt-up jobs

11

https://intecprinters.iweb-storage.com/s/IjU2ZmU1YmI0NmExODkyNDdmZjViMTQ3MSI.qsDutwpD2CG5JN_2tiTFXRUMYIs
https://intecprinters.iweb-storage.com/s/IjU2ZmU1YmI0NmExODkyNDdmZjViMTQ3MSI.qsDutwpD2CG5JN_2tiTFXRUMYIs
https://intecprinters.iweb-storage.com/s/IjU2ZmU1YmI0NmExODkyNDdmZjViMTQ3MSI.qsDutwpD2CG5JN_2tiTFXRUMYIs
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1200mm x 297mm banners 
for BannerPod displays

whAt A wonderfUl world!

The CS5000 showing invites printed in just white & clear toner on Curious Skin black from Antalis

Variable data images & text - any envelope type Tri-fold brochures on coated media

Premium greetings cards on Incada® Silk

Virtually any envelope type - including windows

Print white and color onto            dark t-shirts

we’re getting great 
feedback on the wide-
ranging types of products 
you guys are printing on 
the colorsplash  
series.

the world of intec colorsplash 
is a fascinating environment and 
perfect for producing eye-catching, 
premium results - delivering a real 
difference over ordinary printers, 
and an opportunity for wider profit 
margins… 

We’ve showcased a small selection 
of work here to help demonstrate the 
capabilities of the ColorSplash series.

Call Intec for a personal demo or if 
you have any questions about media 

types, production 
techniques which 
you would like to 
discuss.  

We look forward 
to hearing 
from you and 
seeing the 
end results of 
your work! 

continued…

A4 landscape brochure

400gsm business cards 
with spot clear toner

Supports up to banner, SRA3 & 400 micron media
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Whether you run just the basic 
ColorSplash CS4000 or CS5000 print 

engines on their own, or have built 
an integrated production system 

– including stacker 
feeders, shingling 
conveyors, DMP units 

and more - the world 
of creative print is very 
much at your 

fingertips! 
We’re hearing fantastic reports 
from dealers enjoying great 
results on their ColorSplash 
printers - particularly on 
premium quality substrates of 
up to 400 micron and using 
5th color Clear and White 
toner. Envelopes are scoring 
high on the success stories too - with 
window types providing great satisfaction! 

It’s brilliant to get this feedback - our 
marketing dept is 
always happy to 

receive pics of 
your printed 

work to share with 
the world.

INTERNATIONAL HEADQUARTERS
Intec Printing Solutions Limited
Unit 11B, Dawkins Road Industrial Estate, 
Hamworthy, Poole, Dorset BH15 4JP UK
Tel: +44 (0) 1202 845960
Fax: +44 (0) 1202 845961
www.intecprinters.com

AUSTRALIA HEADQUARTERS
Intec Printing Solutions Pty Limited
17/63 Wollongong Street
Fyshwick ACT 2609  
Australia
Tel: +61 1300 292 944
www.intecprinters.com

AMERICAS HEADQUARTERS
Intec Printing Solutions Corporation
16011 N. Nebraska Avenue
Lutz, FL 33549 USA
Tel: +1 813-949-7799
Fax: +1 813-949-7886
www.intecprinters.com

Every Intec consumable sold generates 
a donation to one of several 
charitable causes around 
the world. 

Thank you for helping us make 
the world a better place. 

Team Intec
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fORTHCOMINg ExHIbITIONS…

11 - 13 OcT
STAND E10. Demonstrating all the latest  
in digital colour printing and finishing from our range of products.

Synthetic tagging ideal for luggage & plants

Business cards using White and Clear toner Invites printed and metallic foiled

Sheet labels applied to cosmetics containers

MORE COLORSPLASH wONDERS…

31 May - 10 JunE
Halls 1-17. Although we will not be showing equipment at drupa we 
welcome you to contact us to arrange personal appointments. Ian 
Melville (managing director), Mark Baker-Homes (director of new business 
development) and Kerry Button (International sales manager), will be at 
the show from May 31 to June 3.  
To arrange a personal meeting with any of the guys at the exhibition,  
call: +44 (0)1202 845 960. Or email: kerry.button@intecprinters.com

drupa


